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A chemist sometimes needs to optimize a reaction. This typically involves running this reaction numerous 

times whilst systematically varying physical conditions or reagents in order to find the best combination in 

which the product yield is maximized, or the level of some undesired by-product is minimized.  

Parallel reaction technology and high throughput LC-MS analysis can allow the chemist to run many such 

combinations; however, this approach can also easily lead to new bottlenecks, in particular, the analysis of the 

resulting large body of data. 

Chrom Reaction Optimization is an Mgears plugin that helps solve this problem by quickly processing large 

chromatography, GC/LC-MS datasets and generating automatic reports for further evaluation and decision 

making. Chrom Reaction Optimization tracks a defined set of chemicals across a large number of samples and 

that reports on their levels.  

This document is to help you get started with Chrom Reaction optimization. 

1. Installation 

Before installing Chrom Reaction Optimization, make sure you already have Mnova MSChrom (minimum 

version: 15.0) and Mgears (minimum version: 2.5) installed and running with valid licenses. 

Go to Files>Advanced Plug-ins>Available. Tick the Chrom Reaction Optimization plugin, then press Install. 
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Another option is to drag and drop the Chrom Reaction Optimization installer into the Mnova interface. The 

following dialog will open. Click on Install. 

 

Restart Mnova. 

 

Chrom Reaction Optimization must now be installed. You can check your license status by going to 

Files>Help>License Manager. A green check must appear in the plugin’s status column. 

 

You are now good to go.   



Chrom Reaction Optimization| Starting guide                                                                                                                      

P/N 312 R1.1  Page 5 of 36 

2. Pre-requisite (when analyzing positive and negative mass functions) 

When you wish to analyze positive and negative mass functions together, it is crucial to ensure that your 

Mnova Mass preferences are appropriately configured to detect both positive and negative ionization 

chromatograms. To do so, go to Files>Preferences>Mass (1), navigate to the Setup tab (2), locate and click on 

the Add button  to incorporate your mass functions (3). Select the Positive function (4) then confirm your 

choice by pressing OK (5).  

 

Repeat the operation and choose now the Negative function. Both “+ MS TIC” and “- MS TIC” should now 

appear in the setup. 

 

Click OK to save this configuration. You can proceed now with setting up your reaction optimization analysis.   
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3. The workflow 

Launch Mgears from the Mnova Automation ribbon. The dialog with the usual six tabs will open. 

 

3.1. Input 

Chrom Reaction Optimization (Chrom RO) analysis follows the general Mnova Gears workflow based on its 

five-step setup, the first step being the choice of input data. Mgears can read data from your Disk, Database, 

or from Real-Time acquisition. In this guide, we will work with data from disk directories (please refer to the 

Mnova Gears manual for more details about other input types). 

Click on the  button and select the data files to upload as your Main Directory.  

 

Use the Automatic Detection mode to detect your input files.  

Experiment selection is recommended if your data folder contains different types of data file in order to 

restrict detection to GC/LC/MS and avoid analysis of other undesired file types. In this case, you must select 

the GC/LC/MS experiment type as shown below. 

 

https://mestrelab.com/pdf/manuals/Mnova-Gears-User-Manual.pdf


Chrom Reaction Optimization| Starting guide                                                                                                                      

P/N 312 R1.1  Page 7 of 36 

Important! When using Automatic Detection, make sure your data file extension(s) is included in the 

Mask Manager so that Mgears can recognize the appropriate files correctly. Otherwise, you can manually add 

your standard file extension or custom file formats and press OK. 

 

Using a Mapping file is convenient (but optional) when input files are listed in a .txt or .csv document along 

with other metadata. Mgears will map the information found in the file provided with the information found 

in the selected input directory (on Disk, DB, or RT folder). To add and use a Mapping file, click on the Filter 

icon at the bottom left-hand side of the Mgears dialog.  

 

Click on  and upload your .txt or .csv document with the data and parameters you want to work with. 

 

Now, click on   to set up the parameters to read the mapping file. The Advanced Filtering Options dialog 

will open. 
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In the Advanced Filtering Options dialog, you must set the column with the data file names for matching. You 

can either indicate the number of the column directly by clicking on this box , or open the assistant to 

visualize the CSV and select the corresponding column, as shown in the image below. Click on OK to save the 

selection.  

Note.  In the CSV column Detection dialog, only the first 10 rows of the filtering file will be loaded. 

 

Important! Remember that in order to be correctly read by Mgears, the CSV separator (comma, 

semicolon, tab, or vertical line) should be configured in Settings tab (in this case, the CSV is using a comma as 

a separator, therefore we select the comma in the Settings). 
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Other filtering options can be configured for the mapping file. You can, for example, set the Starting Row at 

which matching should start, decide whether to Read Until a specific row, or Allow Gaps in the results.  

The well plate position (A1, A3...) can also be matched. 

 

Once you’ve completed configurating your filtering options, click on OK.  

You can now perform an automatic inspection of the selected directory by clicking on  to check if your 

input files have been found and filtered correctly. 
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3.2. Processing  

In the Processing tab, you can optionally upload a script to apply customized processing options. 

 

In this analysis, we will not be setting up any Processing options. 

3.3. Plugins 

In the Plugins section, select and add the Chrom Reaction Optimization plugin.  
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Then, click on Chrom Reaction Optimization Plugin Settings to configure your analysis and report parameters.  

 

A dialog with four tabs should appear.  

3.3.1. The Input tab 

In the Input tab, you must declare the chemical reaction components that need to be monitored. For each 

component, you must provide at least one of the following: a Mol.file, SMILES code, molecular formula, MZ, 

or a Retention Time (RT). This information will be used to identify and assign chromatogram peaks to the 

components, so the choice of the information provided in this regard is critical to an accurate assignment. 

Click on   to add a reaction component.  
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Note. The first time you click on the Add button you will get a message informing you that changes in the 

reaction components may affect the analysis formulae used in the evaluation and the output configuration. 

Make sure to review those and amend them according to your changes before launching the analysis.  

 

 

A new line is added to the table. Fill in the Name and Type of the compound you wish to monitor. The 

compound can be a reaction start material, product, by-product, or an internal standard that will serve for 

relative quantification. When a compound is known but undesired or uninteresting to the analysis, it is possible 

to set it as “ignored”, and in this way the peaks from that compound will be excluded from the analysis. 

 

 

Note. Duplicate component names are not allowed within this system. Whenever you attempt to input the 

same name twice manually, a warning message will promptly appear to alert you. Likewise, if you happen to 

be using older settings that contain duplicated component names, you will receive a warning message when 

loading these settings into Mgears. This message will inform you that the duplicated name has been replaced 

by another to ensure the uniqueness of component names within the system. 
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Complete the table row by entering the information that will be used for peak assignment and quantification.  

To add a Mol.file, simply double-click on the cell. A dialog will open, allowing you to browse your files and 

select the Mol.file. Once you've selected your file, click OK, and the file path will appear in the cell. 

To delete a previously added file, you can click on , then press OK. 

 

To add a SMILES code, molecular formula, MZ, or a Retention Time (RT), simply type your value inside the 

corresponding cell. 

When providing a Mol.File, SMILES, or Molecular Formula, the component is matched using the Molecule 

Match feature. When providing an MZ, the component is matched using the main peak of the auxiliary EIC for 

that MZ.  

In cases where a particularly stringent assignment method is needed, you can provide both an RT range and 

an MZ or molecular formula for a component. In this scenario, the RT information takes precedence, and 

matching MZ peaks must fall within the specified RT range to be assigned. This approach helps eliminate false-

positive MZ matches. 

For detection and peak assignment by mass (i.e., when a structure, a SMILES code, a molecular formula or an 

MZ value is provided for matching), you will need to:   

• Make sure that the component is ionizing properly. If ionization is poor, it is recommended to set 

detection by RT. 

• Use the MZ of the strongest ionization. In some cases, the strongest ionization is a fragmentation peak 

(e.g., for Boc-protected compounds, M-Boc = M-100).  

• Check that the selected MZ for a component is “exclusive” (i.e., that no other compound is likely to 

give the same fragmentation peak). 

Otherwise, you can define a RT or an RT range for detection and peak assignment. 
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A Color can be attributed to each component. This color will be used in the results file to highlight the peaks 

in the spectra, and to designate the compound in the graphics showing the composition of the samples (e.g., 

Pie and Bar Charts).  

 

When requiring an absolute quantification, it is possible to add an external calibration output file or a 

calibration value to be taken into account in calculations. To do so, double click on the cell. 

 

A new Calibration dialog will open. Here, you can:  

− Select and add a Chrom Calibration output file (a JSON file): calibration information will be imported 

and used in the current analysis.  

  

https://mestrelab.com/software/mnova-gears-chrom-cal/
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− Manually enter a calibration value. This value is the gradient of a Peak Area vs. Concentration plot. 

When using this option, the calculation of the compound concentration is achieved by dividing the 

Peak Area by the gradient. 

 
 

To remove a previously added calibration file or value, check the None option, then OK. You can also 

check the Use for all components option if you want to delete all calibration information at once. 

 

Complete your components table by repeating all the previous steps.  

You can always delete unwanted components from your table by selecting the row and clicking on , or 

you can otherwise edit the various columns in the table as needed. 

 

In the CSV section, the path to the CSV mapping file will be displayed if one has been uploaded in the Mgears 

Input tab. If no file has been uploaded, this section says “No CSV Input”.  
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3.3.2. The Analysis tab 

3.3.2.1. The LC/MS Evaluation tab 

In the LC/MS Evaluation tab, the initial step involves configuring the chromatogram extraction preferences. 

To get started, click on the Add button , which will open a dialog box containing the Chromatogram 

Parameters.  

Select the analytical trace type (TIC, DAD, DAD range, PDA, or other relevant trace type) for chromatogram 

extraction. Then, decide whether you want to perform chromatogram alignment automatically or manually. 

We strongly recommend opting for manual alignment. In the case of manual alignment, you will introduce a 

specific value, which will be applied to the chromatogram to align it with TIC.  (Please refer to this article to 

see how you can calculate the time-shift required to align chromatograms manually with Mnova). 

 

In this dialog, it is also possible to Apply Trace Baseline Correction. The Filter and Smooth Factor can be set 

manually by (1) typing the value, (2) using the cursor, or automatically by (3) autodetection. 

 

Once you have adjusted your chromatogram parameters to your satisfaction, remember to click OK to save 

your settings. 

https://resources.mestrelab.com/chromatogram-alignment-with-mgears/
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In the main LC/MS Evaluation tab, you can configure some other parameters related to the chromatograms. 

For instance: 

− If you wish to modify the peak detection parameters, you can access the Peak Detection Options by 

pressing this   button. 

− If you are using a mass to assign a component, it will be necessary to set the Tolerance for the auxiliary 

EIC extractions generated by the automation. 

 

− If you are using a molecular formula to assign a component, you can access and modify the MolMatch 

settings by pressing this   button.  

− If you are using an RT or RT range that are defined prior to chromatogram alignment, check the RT 

alignment correction option to make sure those values are corrected. 

 

− When re-analyzing a dataset, you can check the Force RT Range as Integrated area option to use the 

RT range as the total reaction component peak width. It's important to note that this option is 

accessible exclusively when initiating a re-analysis from the Mgears result viewer as explained in the 

Results section. Enabling this option ensures consistent quantitation of a component across all 

samples on the plate, as it uses the same peak range for measurement in every case. 

 

3.3.2.2. The Unknows tab 

Chrom RO allows you to evaluate and report unknown peaks found in your spectra. If you wish to do this, you 

must enable the Evaluate unknowns option and set the peak Area threshold. The unknown peaks will be 

reported in the Mgears viewer, and the reports generated by the analysis. 

 

Additionally, you have the option to Report unknowns in last CSV columns. When this option is enabled, the 

RT and areas of the unknown peaks in each sample will be added to the last columns of the CSV output.  
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3.3.2.3. The Formulas tab 

Within the Chrom RO tab, you have the ability to craft your own custom output values by creating formulas 

based on the default outputs generated by the plugin. To get started with this process, click on the pencil icon 

 to enter a new formula. This action will open a new dialog box. 

 

Inside the dialog box, click the Add button . This will insert a new line into the table. Edit the parameter's 

name as needed. Then, enter your custom formula in the designated space and decide how many decimal 

places you want to display in the resulting value. 

 

 

The formulas you create can only be generated using a limited set of parameters, including component areas 

(and concentrations, if calibration data is available), as well as the total area and total concentration. To see 

the available parameters for each analysis, click this icon .  
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Please note that the total area or concentration does not include the Internal Standards, as they are not part 

of the reaction. However, you can use the internal standard area or concentration for calculations. 

 

Tip. Clicking on an item in the dropdown menu will copy the parameter name to the clipboard, allowing you 

to conveniently paste it into the formula editor cell. 

After you have written your formula, you can test its validity by clicking the checkmark button . If the formula 

is not valid, a warning message will appear, prompting you to make the necessary adjustments. 

 

3.3.3. The Quality Controls tab 

In the Quality Controls tab, you can activate a series of quality tests to identify various anomalous situations 

that may require manual correction. Failed controls will trigger a flag for the sample and report the 

components or peaks that failed the test, facilitating a review-by-exception approach. There are five options 

available which can be configured: 

− Peak Not Assigned: If enabled, a flag will be raised when peak assignment for a component fails.  

− Assignment Overlap: If enabled, a flag will be obtained when two or more components are assigned 

to the same peak.  

− RT Outlier: If enabled, a threshold must be defined (a factor of the Standard Deviation; xSTD). A flag 

is obtained when the distance [RT-mean RT] exceeds the accepted threshold.  
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− Multiple Peak in RT range: This control is only available when an RT range is defined for at least one 

component. If enabled, a flag is obtained when multiple peaks are detected in the specified RT range. 

− RT/MS Mismatch: This control is only available when an RT value or range and a mass (SMILES, 

structure, molecular formula, or mz provided) are provided for at least one component. If enabled, a 

flag is obtained when the matched mz peak does not elute at the define RT or RT range. 

Enable the option(s) of interest, then edit the flag text and click on the color selection button to choose the 

flag color. Click on OK to save your preferences. 

 

An additional control on the overall well plate is also available, the Accepted RT variation. If enabled, a 

threshold must be defined, and a flag will be obtained when the spread (max-min) of the RT of a component 

across all samples exceeds the accepted threshold. 

Finalize your plugin settings setup by pressing OK and move to the next step. 

3.3.4. The Output tab 

Within the Output tab, you have the flexibility to customize the CSV output configuration to align it with your 

specific requirements. To begin, you can choose whether to name this file in accordance with the results folder 

you will configure in the Mgears Output tab or opt for the default naming convention, which is "results.csv." 
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Next, simply click on Configure Output to access the dialog box where you can select which parameters to 

include in your output. This action will open a new window, where each tab corresponds to a distinct source 

of information. These sources encompass the outcomes of the automation process, data extracted from the 

input CSV file (if it is part of your workflow), and parameters derived from the raw datafile's metadata, typically 

found in the Parameters table within Mnova. For all three data sources, you will have the flexibility to export 

the values to the output CSV file, the Mgears Viewer, and the HTML report. 

Note. If you have added a CSV mapping file in the Input tab, Mgears will automatically detect this file and 

will allow you to configure the output CSV based on its structure, as is the case in this analysis.  

3.3.4.1. The Automation Variables tab  

By default, this table will include: 

- The Name of the sample and the Well plate position information, if provided, during the mapping file 

configuration (in the Mgears Input tab). 

- For each component (other than Internal Standard or Ignored components) declared in the Chrom RO Input 

tab: 

- RT 

- Area 

- %Area 

- Relative Area to the Internal Standard (If an Internal Standard is present) 

- Concentration (If there is a calibration for the component) 

- %Concentration (If there is a calibration for the component) 

- Relative Concentration to the Internal Standard (If a calibration is applied to both the Internal 

Standard and component) 

 

- For a component declared as Internal Standard (If present): 

- RT 

- Area 

- Relative Area (Its value is expected to be 1) 
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- Concentration (If there is a calibration for the component) 

- Relative Concentration (Its value is expected to be 1) 

 

- If an Internal Standard is present, the Sum of relative areas of all components is also included. 

 

- If the option to Evaluate Unknowns is enabled, the Unknows Area, total percentage of Unknown Peaks 

area and a text describing the unknown Peaks [list of RT(%Area, mz)] are also included. 

 

For each Parameter, it is possible to configure an Output Column and Output Header and decide whether to 

include them in the HTML report (Print to HTML). 

 

To choose the Output column, you can either: 

A. Select the cell and type the value: 
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B. Double-click on the cell to open the CSV Column Detection assistant and select the desired column: 

 

C. Click on this button  to automatically generate output column values for all the parameters in the 

table: 
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If you already have assigned certain columns to other parameters in the other tabs (CSV File and/or 

Mnova Parameters Table), a message will appear to inform you that the automatic assignment will 

start right after the last assigned column, as seen in the image below. 

 

To clear Output Column values, you can press this button . 

To edit the CSV Output Header, you must select the cell and type the header of your choice. 

 

To include the parameters to the HTML report, tick the corresponding box in the final column. 

You can quickly select/unselect all parameters using the buttons / , respectively. 

 

Note. The Automation Variables tab will be updated whenever a component is added or modified in the 

Reaction Components table of the plugin. 

In this analysis, we will use the following configuration for the Automation Variables. 
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3.3.4.2. The CSV File tab  

Here you can manually add other parameters included in your input mapping file to the output CSV. Click on 

the add button, . A new row will be added to the table.  

Click and edit the parameter name, Input column and Header, and Output column and Header, etc.  

Enable the Print in Viewer/HTML if you wish to include the parameter to the viewer and the HTML report. 

The selected parameter will be added in the Metadata tab of the Results section in Mgears Viewer. 

Repeat the workflow to add all the parameters you wish to include. 

 

You can always select a row and click on  to remove an entry.   
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3.3.4.3. The Mnova Parameters Table  

To include a parameter from the Mnova parameters table in the final report, a datafile must be open in Mnova 

(1). Click on the add button  (2). The program will collect the Mnova parameters from the active spectrum 

and display them in a new dialog. Select the parameters you want to export (3) and click on OK to save your 

choices (4). The selected parameters will appear in the table as shown below (5).  

Add a value for the Output column, edit the Output Header, and enable printing the results in the Mgears 

viewer and HTML report if needed. 

 

You can always select a parameter and press  to remove it from your CSV output.  
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Now that you have completed the CSV Input/Output configuration, you can click on  at the bottom left-

hand side of the configuration dialog to view a simulation of the output CSV. An overview of the CSV output 

will be displayed. The columns that will contain automation data are colored grey. 

 

3.4. Design 

In the Design tab, you can use Mnova layout templates to produce final, customizable reports or even select 

your own scripts. 

3.5. Output 

Choose a directory to which Mgears can save the analysis results.  

 

Optionally, enable the Add Nickname to the Results Folder and type the nickname of your choice. 

 

Enable the Mnova document creation to be able to review the resulting spectra in Mnova. 
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You can also choose to create a PDF with the results or save the results to a database (please refer to the 

Mnova Gears manual for more details on the output configuration options). 

Now that everything is set, click on to start the analysis.  

 

4. The output folder 

The results folder is saved under the directory previously specified and contains all the output generated by 

the current evaluation. 

   

https://mestrelab.com/pdf/manuals/Mnova-Gears-User-Manual.pdf
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4.1. The HTML file  

In the HTML report, an overview of the results is made available. Each sample is reported in a row, along with 

the predefined parameters (as per the output settings).  

  

The HTML format allows you to change the display of the columns and adapt them to your preferences. Click 

on Columns and select/unselect the parameters you wish to display/hide. 

You can also Copy, Print, or save these results into CSV or PDF formats. 
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4.2. The CSV report 

The output folder named “ChromRO” contains the CSV file with all the output and input information as 

predefined in the output settings. 

 

4.3. Other output 

- A “documents” directory, containing the output Mnova files (unless Mgears is configured to save Mnova 

files in another location). 

- A log file of the execution. 

- A copy of the settings used in the current evaluation. 

- A resume file of the steps followed in the execution. 

- A CSS folder, a data folder, a JS folder, and an images folder. 

5. The Mnova Gears Results Viewer 

Chrom RO has two different – but interconnected – result viewers, the Mgears Viewer, which displays overall 

results for the sample/well, and the Chrom Reaction Optimization Viewer, which displays individual 

components RT statistics for each reaction dataset.  

5.1. The Mgears Viewer 

Open the Mgears Viewer, then click on  to open your analysis results. 
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When the experiment is open, the Mgears Viewer shows the individual results datasets, a well plate view, and 

the associated numerical results and metadata.  

 

Click on a specific dataset to view the corresponding results and spectrum in Mnova.  
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5.1.1. The Well plate view 

The Well Plate view is highly adaptable, allowing you to present results in a manner that suits your 

preferences. You can choose to showcase numerical data, such as the percentage area of various reaction 

components or the outcomes of your custom formulas. Alternatively, you can opt for graphical 

representations, including bar graphs and pie charts, to visualize the results. 

 

 

Some examples of results presentations are given below: 
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5.1.2. The Results section 

The Results section includes different tabs with information relating to: 

• Reaction components Results with the Matched peak’s RT, Area, and %Area. 

• Unknowns results, if unknowns’ analysis is enabled in the plugin settings. 

• Formulas results, if custom formulas are introduced to the analysis. 

• Extracted Metadata, if output parameters are set to appear in the Mgears viewer. 

• Controls results, if quality tests are enabled. 

• RT Statistics for each component peak within the well, encompassing the RT and its deviation from 

the mean RT calculated across all samples as well as a score to evaluate the RT outliers (defined as 

[RT- Mean]/STD). 

 

Within the Results section, you will also find a set of tools designed to facilitate the correction and refinement 

of your analysis. For example, if a peak assignment has encountered an error or is incorrect, you have the 

option to effortlessly remove the assigned peak and proceed to manually reassign this component to another 

peak within your spectrum or spectra. You can also open the Chrom Reaction Optimization dialog box to edit 

some settings and quickly relaunch the analysis on the same samples.  

5.1.2.1. Removing peak assignment 

To address an incorrectly assigned component, simply click on the corresponding component row (1), and 

then press the  button (2). Mgears will recalculate and update the results for the selected well (3). 
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All the Mgears tables and spectra are automatically updated, as can be seen below: 

 

5.1.2.2. Re-assigning a peak 

To manually assign a peak to a component, select the component row (1), then press the  button (2). A 

dialog with a list of detected chromatographic peaks appears. Select the peak you wish to assign (3) and press 

OK (4). Mgears will recalculate and update the results for the selected well (5). 
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All the Mgears tables and spectra are automatically updated, as can be seen below: 

 

5.1.2.3. Editing analysis settings 

To edit analysis settings and quickly relaunch the analysis on the same samples, press on the Brick icon  in 

the Results section. This will open the Chrom Reaction Optimization Settings dialog box from which you can 

add a new component or modify the RT, color, and external calibration of the added components in the Input 

tab. In the LC/MS Evaluation tab, only the Force RT Range as Integrated Area option can be modified. In 

addition, you can modify the Unknowns window, add, delete, or modify Formulas, edit the Controls and 

modify the Output. 

If you enable the Force RT Range as Integrated Area option the peak is integrated in exactly the provided RT 

range. 

When you have finished, click on OK to save your changes. 
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Now click on Analyze again in the Mgears viewer and select Analyze Again All Results. Mgears will recalculate 

and update the results for the whole well plate. 

 

The new results will be automatically saved to your output folder.  

5.2. The Chrom Reaction Optimization Viewer  

You can launch the Chrom Reaction Optimization Viewer directly from the Mgears Viewer interface by clicking 

the  button. This viewer includes a comprehensive Peaks Statistics table featuring essential data such as 

peak RT mean, standard deviation, variation range, and the outcome of the Control test, if enabled. 

 

 

For more details on Mnova Gears’ options, please refer to the Mnova Gears manual. 

https://mestrelab.com/pdf/manuals/Mnova-Gears-User-Manual.pdf
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